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Read This First
The Q-Station Help and Q-Station User Manual are intended to assist you with the safe and
effective operation of your product. Before attempting to use the product, read the user
information and strictly observe all warnings and cautions.

The user information for your Philips product describes the most extensive configuration of the
product, with the maximum number of options and accessories. Some functions described may
be unavailable on your product's configuration.

Intended Audience
Before you use the Q-Station software, you need to be familiar with diagnostic techniques.
Sonography training and clinical procedures are not included here.

This document is intended for sonographers, physicians, and biomedical engineers who operate
and maintain your Philips product.

Intended Use
This product is intended to be installed, used, and operated only in accordance with the safety
procedures and operating instructions given in the product user information, and only for the
purposes for which it was designed. However, nothing stated in the user information reduces
your responsibility for sound clinical judgment and best clinical procedure.

Installation, use, and operation of this product are subject to the law in the jurisdictions in
which the product is used. Install, use, and operate the product only in such ways that do not
conflict with applicable laws or regulations, which have the force of law.

Use of the product for purposes other than those intended and expressly stated by Philips, as
well as incorrect use or operation, may relieve Philips or its agents from all or some
responsibility for resultant noncompliance, damage, or injury.

WARNING
United States federal law restricts this device to sale by or on the order of a physician.

1
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WARNING
System users are responsible for image quality and diagnosis.

WARNING
The user is solely responsible for custom measurements and calculations and for the accuracy
of elements entered into the equations.

NOTE
The Q-Station software is not intended for long-term storage and should only be used to store
patient data that you are currently investigating. Short-term storage is limited to a user-defined
amount of free space on the local hard drive, which can be susceptible to failure. To ensure
data security, patient data should also be stored on a secure storage device (a PACS).

User Information Components
The user information provided with your product includes the following components:
• Q-Station User Manual: Introduces you to features and concepts and helps you set up and

configure your software.
• Q-Station Help: Available on the product in some languages, the Q‑Station Help contains

comprehensive instructions for use. It also provides descriptions of all controls and display
elements. To display the Help, click Help.

• Q-Station Operating Notes: Contains information that clarifies certain product responses
that might be misunderstood or cause user difficulty.

• Shared Roles for System and Data Security: Contains guidelines to help you understand how
the security of your Philips product could be compromised and information on Philips'
efforts to help you prevent security breaches.
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User Information Conventions
The user information for your product uses the following typographical conventions to assist
you in finding and understanding information: 
• All procedures are numbered, and all subprocedures are lettered. You must complete steps

in the sequence they are presented to ensure success.
• Bulleted lists indicate general information about a particular function or procedure. They do

not imply a sequential procedure.
• Control names and menu items or titles are spelled as they are on the system, and they

appear in bold text.
• The pointer is the cursor used to select elements on the display.
• Point means to position the tip of the pointer or cursor on an item on the display.
• Click or select means to move the pointer to an object and press the primary mouse button.
• Double-click means to quickly click twice to select an object or text.
• Drag means to place the cursor over an object and then click and hold while moving the

object.
• Hover means to pause the pointer over an item on the display.
• Right-click means to point at an item and then press the right mouse button, without

moving the mouse.
• Shift+click means to press and hold the Shift key while clicking an item on the display.
• Ctrl+click means to press and hold the Ctrl key while clicking an item on the display.

Information that is essential for the safe and effective use of your product appears throughout
your user information as follows:

WARNING
Warnings highlight information vital to the safety of you, the operator, and the patient.

CAUTION
Cautions highlight ways that you could damage the product and consequently void your
warranty or service contract or ways that you could lose patient or system data.
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NOTE
Notes bring your attention to important information that will help you operate the product
more effectively.

Upgrades and Updates
We are committed to innovation and continued improvement. Upgrades may be announced
that consist of software improvements. Updated user information will accompany those
upgrades.

Customer Comments
If you have questions about the user information, or you discover an error in the user
information, in the USA, please call Philips at 800-722-9377; outside the USA, please call your
local customer service representative.

Customer Service
Customer service representatives are available worldwide to answer questions and to provide
maintenance and service. Please contact your local Philips representative for assistance. You
can also contact the following office for referral to a customer service representative, or visit
the Philips Healthcare "Contact Us" website:

www.healthcare.philips.com/main/about/officelocator/index.wpd

Philips Ultrasound Headquarters

22100 Bothell-Everett Highway, Bothell, WA 98021-8431, USA

800-722-9377
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Q-Station Installation
To ensure that the Q-Station software installs successfully and operates correctly, it is critical
that you perform the installation procedure exactly and in the order written. Also, because
Philips provides remote support for the Q-Station software, Philips requires that the Q-Station
computer have Internet access.

Some procedures require using the computer's operating system (OS) software and not the
Q‑Station software. Detailed instructions for performing those OS procedures are not included
here, because the procedures could vary depending on the OS type and version. For detailed
instructions, see the Windows operating system Help. This user manual provides suggested
phrases to search for in the Windows Help.

The installation procedure comprises the following tasks:
1. Verify that the computer meets or exceeds the minimum requirements (see “Computer

Requirements” on page 14).
2. Confirm or collect the network information (see “Network Requirements” on page 16).

CAUTION
If the Q-Station PC is part of a wireless network, use only secured wireless technologies. For
more information about network security, see Shared Roles for System and Data Security,
which is included on the User Information CD.

3. Install the software (see “Installing the Software” on page 22).
4. Register the software and obtain the license file (see “Software Registration” on page 24).
5. Restart the computer.
6. Verify the software installation (see “Verifying the Software Installation” on page 28).
7. Establish the remote connection (see the “Remote Services” section).

2
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Computer Requirements
Before the software can be used on your computer, your computer must meet or exceed the
following minimum requirements. For more information, search the Windows Help for get
information about your computer.
• Processor:

– Intel Core 2 Duo or greater
– AMD Athlon 64 X2 or greater

• Operating system:
– Windows XP Professional Service Pack 3, 32 bit
– Windows 7 Service Pack 1, 32 bit
– Windows 7 Service Pack 1, 64 bit

• Software:
– Microsoft Word 2007
– Microsoft Word 2010
– Microsoft Word 2013

• Memory: 4 GB RAM
• Graphics: 64 MB or greater with hardware-accelerated Open Graphics Library (OpenGL) and

Pixel Shader 3.0 support
• Hard drive: 30 GB of available space
• Monitor: 1600 x 1024 or greater resolution, 32-bit color
• CD/DVD drive
• USB port
• LAN port
• Mouse with a scroll wheel
• Standard Microsoft (or equivalent) keyboard
• Current antivirus software

NOTE
Q-Station does not support Windows Vista.
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NOTE
If you are installing on Windows XP, you must remove MSXML 6 Service Pack (SP) 2 from the
destination computer before installing the Q-Station software. If MSXML 6 SP2 is present, the
System Configuration Check fails. See “Removing MSXML 6 SP2” on page 15.

NOTE
You cannot install the Q-Station software on a computer if the DPI (text size) setting is set to
Large Size. The DPI setting must be Normal Size.

NOTE
To determine your computer's hardware specifications, see the computer's hardware
documentation, contact the manufacturer, or search the Internet.

NOTE
If you are unsure that your computer meets the minimum requirements, continue the
installation. The System Configuration Check will alert you to any discrepancy.

NOTE
If your computer meets only the minimum requirements, the software installation could
require more time to complete than it would on a computer that exceeds the requirements.

Removing MSXML 6 SP2
The Q-Station SQL database does not install correctly if the Microsoft MSXML 6 SP2 is installed
on the destination computer. Before installing the Q-Station software, remove the MSXML 6
SP2.
1. On the destination computer, do one of the following:

• For Windows XP, open Add/Remove Programs.
• For Windows 7, open Programs and Features.

2. If the Microsoft MSXML 6 SP2 is listed as an installed program, select it and click Remove.
3. Do one of the following:
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• If the removal is successful, you can ignore the remaining steps of this procedure and
install the Q-Station software.

• If the removal fails, go to step 4.
• If the removal is successful, but Q-Station installation still fails, go to step 4.

4. In the Tools directory of the Q-Station Installation DVD, double-click msicuu2.exe.
5. Install the Clean Up utility by following the prompts in the Windows Installer Clean Up

Setup wizard.
6. Click Start and All Programs, and then select Windows Install Clean Up.
7. In the list of programs, select MSXML 6 Service Pack 2 (KB954459) [6.20.1099.0].
8. Click Remove.

Network Requirements

CAUTION
If the Q-Station PC is part of a wireless network, use only secured wireless technologies. For
more information about network security, see Shared Roles for System and Data Security,
which is included on the User Information CD.

Before installing the Q-Station software and to ensure a complete and successful installation,
Philips recommends that you confirm or collect specific network information. The network
information is required for these purposes:
• To allow installation of the Q-Station software
• To enable the Q-Station computer to operate in your network environment, exchange data

with DICOM devices (PACS and ultrasound systems), and accept remote support from
Philips

If your facility has an information-technology (IT) department, confer with the IT network
administrator as necessary.

Network Requirements for Q-Station Installation
The following network requirements are for installing the Q-Station software onto your
computer.
• Access to the Internet
• Port 443 (outbound only) open in the firewall
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• Port 80 (to enable automatic registration) open in the firewall
• If a proxy server is used, you need the proxy server address, the user name, and the

password.

NOTE
Port 443 is used for secure websites (URLs that begin with "https://"), and port 80 is used for
regular websites. Most facilities that have Internet access have those ports open in the firewall.

Network Requirements for Configuring the Q-Station Computer
The items listed in the "Setting Name" column of the following tables are the network
requirements for configuring the Q-Station computer to operate in your network environment
and accept remote support from Philips. Some of these items may not apply to your network.
Write the settings that apply to your network in the spaces provided.

Q-Station Computer Settings
Setting Name Setting for Your Network
Automatic IP Address  
Fixed IP Address  
 Subnet Mask  
 Default Gateway  
 DNS Server  
AE Title  
Port Number  

Ultrasound System 1 Settings
Setting Name Setting for Your Network
IP Address  
AE Title  
Port Number  
Device Name1  
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1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

Ultrasound System 2 Settings
Setting Name Setting for Your Network
IP Address  
AE Title  
Port Number  
Device Name1  

1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

Ultrasound System 3 Settings
Setting Name Setting for Your Network
IP Address  
AE Title  
Port Number  
Device Name1  

1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

Archive PACS Settings
Setting Name Setting for Your Network
IP Address  
AE Title  
Port Number  
Does the system support Native
Data?

 

Does the system support
Structured Report?

 

Device Name1  
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1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

Query/Retrieve PACS Settings
Setting Name Setting for Your Network
Does this system use the same
settings as the archive PACS?

 

IP Address  
AE Title  
Port Number  
Device Name1  

1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

Send PACS Settings
Setting Name Setting for Your Network
Does this system use the same
settings as the archive PACS?

 

IP Address  
AE Title  
Port Number  
Device Name1  

1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

DICOM Storage Commit Settings
Setting Name Setting for Your Network
IP Address  
AE Title  
Port Number  
Device Name1  

 

 

 

 

 

 

Network Requirements Q-Station Installation

Q-Station User Manual 4535 617 35291 19



1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

DICOM MPPS:RIS Settings
Setting Name Setting for Your Network
IP Address  
AE Title  
Port Number  
Device Name1  

1. The Device Name is a name you choose for a specific device (such as an ultrasound system
or a server). It is the name that appears in Q‑Station messages and dialog boxes regarding
that device.

Audit Server Settings
Setting Name Setting for Your Network
IP Address  
Host Name  
Network Protocol TCP

UDP
Port Number  

Computer Security Policy Option
The computer security policy option offered during the software installation is designed to
increase the security of patient data by changing some of the Windows OS settings. It is
intended for use in office environments that do not have an information technology (IT)
department. If your office has an IT department, your office probably has a security policy. Ask
your IT department if you should select this option during installation. After the computer
security policy option is enabled, no "undo" function is available. The system administrator
must manually restore the OS settings.
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Computer Security Policy Settings and Default Values
If you select the computer security policy option during installation, it changes the
Administrator account name, changes the policies for passwords and the locking and disabling
of accounts, and sets default values for those policies.

The computer security policy option changes the Administrator account name for these
reasons:
• Administrator is an easy access point for hackers, because it has a known name.
• Changing the name increases system security.

An account is locked for 5 minutes, if 10 invalid log-on attempts occur within 5 minutes.

The password policy is enforced as follows:
• Logging on requires a user name and password.
• Strong passwords are required.
• A password-protected screen saver appears after 15 minutes of inactivity.
• The 12 previous passwords are not allowed.

A strong password has the following properties:
• A minimum length of eight characters
• Three of four character types (uppercase, lowercase, number, and a special character)
• Must be changed every 90 days
• Cannot contain the associated user name
• Cannot contain words that can be found in a dictionary
• Cannot contain repeated or sequential letters or numbers (for example: abcd, aaa, 5432,

1111)

Changing the OS Policy Settings
You must have administrator privileges and use the Windows OS interface and tools to change
the policy settings. For details, search the Windows Help for local security settings.
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Installing the Software
To install the software, you must be logged on with local administrator privileges. Philips
recommends that you create a unique local administrator account (for example, QAdmin) to
install the Q‑Station software. Using a renamed local administrator account increases the
security of the Q‑Station software installation and data. You can use that account after the
installation to verify Q‑Station operation.

For more information about computer security, see “Computer Security Policy Settings and
Default Values” on page 21.

CAUTION
If you are upgrading from a previous version of the Q‑Station software, do not uninstall the
previous version. Uninstalling the previous version before upgrading to the current version
may result in an inability to reattach an existing patient database.

NOTE
Installing Q-Station software automatically upgrades any previous version.

NOTE
During installation, some antivirus applications or other software programs designed to protect
the PC may display warning messages that alert you that unknown software is being installed.
Ignore or close those messages, and allow the Q-Station installation to proceed.

The installation wizard performs the software installation and prompts you at various times
during the installation as it proceeds through the installation sections.
1. Before you begin the installation:

• Ensure that the target computer meets the minimum requirements (see “Computer
Requirements” on page 14 ).

• If the target computer is on a network, ensure that the network meets the minimum
requirements (see “Network Requirements for Q-Station Installation” on page 16).
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• Ensure that you have the original Q-Station DVD case available. It has the Q-Station
serial number, which is required for the registration process.

2. Create the QAdmin account. For details, search the Windows Help for add a new user to
the computer.

3. Use the QAdmin account to log on to the computer.
4. Place the installation DVD in the CD/DVD drive and wait a few moments for the installation

wizard to start.
5. If the installation wizard does not start automatically, use Windows Explorer to navigate to

Setup.exe on the DVD, and then double-click Setup.exe to start the installation.
6. On the Welcome display, select the installation language and click Next.
7. Read and accept the license agreement. (If you do not accept the license agreement, the

installation wizard prompts you to exit the installation.)
8. Click Next.
9. In the System Configuration Check dialog box, do one of the following:

• If the system passed the System Configuration Check, click Next.
• If any item has a warning, review it carefully. You may choose to correct the item

before proceeding with the software installation, or you may choose to continue the
software installation without correcting it. If you choose to continue the software
installation, click Next.

• If any item failed, the software installation stops. Exit the software installation and
resolve the item before restarting the software installation.

10. In the Configure Patient Database dialog box, select a destination drive and set the amount
of disk space for the patient database.

11. Click Next.
12. The installation wizard prompts you to select whether to apply the computer security policy

option. For details about this feature, see “Computer Security Policy Option” on page 20. If
you do not want to apply the computer security policy option, select Maintain existing
computer security policies.

NOTE
After the computer security policy option is enabled, no "undo" function is available. The
system administrator must manually restore the OS settings.

13. Click Install.
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14. The installation wizard checks for Microsoft .NET Framework. If the computer has
Microsoft .NET Framework installed, the Q-Station software installation continues. If the
computer does not have Microsoft .NET Framework installed, the installation wizard installs
it and restarts the computer to complete the .NET Framework installation; this requires you
to log on to continue the Q-Station software installation.

15. The main part of the software installation continues, which requires approximately
30 minutes to complete. Meanwhile, the main progress indicator may seem to be inactive
for several minutes, but other dialog boxes in the background show activity. This is normal.
Allow the dialog boxes to process; do not click them or press any key.

16. In the Installation Succeeded dialog box, click Register to launch the registration wizard and
obtain the license file.

NOTE
If the Installation Failed dialog box appears, follow its instructions to restart the computer and
restart the software installation.

Software Registration
Before you can use the Q-Station software, you must register it to obtain the license file. There
are two methods for registering the software and obtaining the license file:
• Automatic registration, which occurs when the Q-Station computer is connected to the

Internet.
• Manual registration, which is required when the Q-Station computer is not connected to

the Internet. This method requires using another computer that is connected to the
Internet.

Automatically Registering the Software
If the Q-Station computer is connected to the Internet, complete the following steps. If the
Q‑Station computer is not connected to the Internet, see “Manually Registering the Software”
on page 26.
1. Ensure that you have the following items available:

• A registration name (your name)
• Your valid e-mail address
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• The Q-Station software serial number from the Q-Station DVD case
2. In the Q-Station registration wizard, select I Am Connected to the Internet and Would Like

to Register Now, and then click Next.
3. Type the required information, and then click Next.
4. Type the Q-Station serial number (from the DVD case) in the Serial Number text box and

click Next. The registration wizard automatically obtains the license file and displays the
Registration Complete message.

NOTE
The license file is specific to your Q-Station computer and cannot be used with another
computer.

5. In the Registration Complete dialog box, select I Would Like to Back Up My License File,
and click Finish to make a backup copy of the license file.

6. In the Select Backup Location dialog box, select the location to which you want to save the
license file and click Save.

7. Do one of the following:
• If the Installation Succeeded dialog box appears, click Restart to restart the computer

and complete the software installation.
• If the Installation Succeeded dialog box does not appear, manually restart the

computer to complete the software installation.
• If the Installation Failed dialog box appears, follow the instructions to restart the

computer and restart the software installation.
8. Verify that the following icons are on the desktop:

• Q-Station icon, for opening the Q‑Station application.
• Q-Assistant icon, for opening the Q‑Assistant tool, which is for configuring the

Q‑Station application
• Q-Setups icon, for opening the Q‑Setups utility, which is for configuring the

measurements and analysis features in the Q‑Station application
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Manually Registering the Software

NOTE
The license file is specific to your Q-Station computer and cannot be used with another
computer.

If the Q-Station computer is not connected to the Internet, complete the following steps. If the
Q-Station computer is connected to the Internet, see “Automatically Registering the Software”
on page 24.
1. Ensure that you have the following items available:

• A registration name (your name)
• Your valid e-mail address
• The Q-Station software serial number from the Q-Station DVD case
• A USB flash memory drive

2. On the Q-Station computer, do the following:
a. Open the Windows Notepad accessory program.
b. In the Q-Station registration wizard, select I am not connected to the Internet. Tell me

how to register.
c. Click Next.
d. Copy the URL from the dialog box and paste it into Notepad.
e. Copy the node ID and paste it into Notepad.
f. Connect your USB flash drive.
g. Save the Notepad file, with a name of your choice, to the USB flash drive.
h. Close Notepad and disconnect the USB flash drive.

3. On the computer that is connected the Internet, do the following:
a. Open an Internet browser window.
b. Connect the USB flash drive that contains the Notepad file with the registration URL

and node ID.
c. Open the Notepad file.
d. Copy the registration URL from Notepad, paste it into the browser's address field, and

go to that URL.
e. Copy the node ID from Notepad, and paste it into the Node ID field of the registration

website.
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f. Enter the remaining required information (name, e-mail address, and Q-Station serial
number from the DVD case) and click OK. The registration website sends the license
file to your e-mail address.

g. Access your e-mail account and retrieve the license file.
h. Save the license file to the USB flash drive.
i. Disconnect the USB flash drive, and take it to the Q-Station computer.

4. On the Q-Station computer, if the registration wizard displays the Welcome to the
Registration Wizard, select I already have a license file and click Next.

5. If the registration wizard is not displayed, do the following:
a. On the Windows desktop, double-click the Q-Assistant icon to open Q-Assistant.
b. Click Options.
c. Click Registration Wizard.
d. In the Welcome to the Registration Wizard dialog box, select I already have a license

file and click Next.
6. Connect the USB flash drive to the Q-Station computer.
7. Click . . . and navigate to the USB flash drive.
8. Right-click the license file and select Open, or double-click the license file.
9. Click Next.
10. In the Registration Complete dialog box, select I Would Like to Back Up My License File

and click Finish to make a backup copy of the license file.
11. In the Select Backup Location dialog box, select the location to which you want to save the

license file and click Save.
12. Do one of the following:

• If the Installation Succeeded dialog box appears, click Restart to restart the computer
and complete the software installation.

• If the Installation Succeeded dialog box does not appear, manually restart the
computer to complete the software installation.

• If the Installation Failed dialog box appears, follow the instructions to restart the
computer and restart the software installation.

13. Verify that the following icons are on the desktop:
• Q-Station icon, for opening the Q‑Station application.
• Q-Assistant icon, for opening the Q‑Assistant tool, which is for configuring the

Q‑Station application
• Q-Setups icon, for opening the Q‑Setups utility, which is for configuring the

measurements and analysis features in the Q‑Station application
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Verifying the Software Installation
After you finish installing the software, use this procedure to verify that it installed correctly
and is ready for use, and to perform some administrative duties.
1. On the Windows desktop, double-click the Q-Station icon. If the application opens, the

software installed correctly.
2. If the application does not open, reinstall the license file as follows, and then try opening

the application again.
a. On the Windows desktop, double-click the Q-Assistant icon to open Q-Assistant.
b. Click the Options tab.
c. Click Registration Wizard.
d. In the Welcome to the Registration Wizard dialog box, select I already have a license

file and click Next.
e. Click . . . and navigate to the location of the license file.
f. Select the license file and click Open.
g. Click Next.
h. Click Finish.
i. In the New License File dialog box, click Activate Now and then click OK.

3. If reinstallation of the license file does not enable you to open the application, do the
following:
a. Uninstall Q-Station software, Q-Assistant, and the Philips Service Agent.
b. Reinstall Q-Station software, which also reinstalls Q-Assistant and the Philips Service

Agent.
c. Perform the verification procedure again.

4. Verify that the license options are correctly installed:
a. Double-click the Q-Assistant icon.
b. Click the System Management tab.
c. Ensure that the Q-Station serial number shown matches the serial number on the

software DVD case.
d. Click Options and ensure that the Q-Apps and features listed match the Q-Apps and

features that you purchased.
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Remote Services
After installing the Q-Station software, Philips recommends that you enable remote access in
Q‑Assistant. Remote access allows Philips representatives to provide any support you may
need. You have full control over remote access. No one can access the Q-Station software
remotely if you do not enable remote access.

After remote access is enabled, the Q-Station software communicates only with the Philips
server specified in the Settings area of the Remote Services tab.

Configuring Remote Services Connection Settings
If your site uses a firewall, ensure that port 443 (outbound only) is open before you configure
remote services connection settings.
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Remote Services tab.
3. Click Settings.
4. Under Connection Settings, ensure that the Server Address is set to M2M Enterprise

Server.

NOTE
Selecting M2M Enterprise Server automatically selects Enterprise URL, Tunnel URL, and RA
URL.

NOTE
The M2M Enterprise Server is the standard server address. Do not select Custom or any other
setting, unless a Philips representative instructs you to do so.

5. In the Connection Type menu, ensure that Internet is selected.
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NOTE
Internet is the standard connection type. Do not select VPN, unless a Philips representative
instructs you to do so.

6. In the Proxy Settings area, if your site uses a proxy server to control Internet access, type
the proxy IP address, user name and password (if used), and indicate whether the proxy
server uses NTLM.

NOTE
You can add only an IP address and port number in the Proxy Settings area (for example,
192.168.0.1:8080). URLs are not accepted.

7. Click Save.
Q-Assistant registers with the Philips M2M server.

8. Click Test Connection and verify that OK appears. OK indicates that a path to the server
exists.

9. If Failed to Connect appears instead of OK, ensure that:
• The computer is connected to the Internet.
• Network settings are configured correctly.
• Port 443 (outbound) is open in the firewall.

Enabling Remote Access
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Remote Services tab.
3. Click Access/Status.
4. Under Remote Desktop, do one of the following:

• To enable permanent remote desktop access, select Enable Permanently.
• To enable remote desktop access only until a date and time that you specify, select

Enable Until, select a date from the menu, and enter a time.
5. In the Remote Desktop confirmation dialog box, click OK to enable remote access.
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Q-Assistant displays a yellow triangle. When the yellow triangle changes to a green circle,
Q-Assistant has successfully established contact with the Philips remote server.
(Establishing contact may require a few minutes.)

6. Under Software Download, do one of the following:
• To allow a Philips representative to download software to the Q-Station computer,

select Enable Download.
• To allow automatic installation of downloaded software, select Install Automatically.
Q-Assistant displays a yellow triangle. When the yellow triangle changes to a green circle,
Q-Assistant has successfully established contact with the Philips remote server.
(Establishing contact may require a few minutes.)

Requesting Online Support
The ability to request online support is an optional feature, available in some countries, that
enables you to send a request to Philips for technical or clinical assistance.

NOTE
The Request Support tab is visible only after you enable online support and submit a support
request.

1. If you are creating an online-support request for the first time, enable online support as
follows. Otherwise, go to step 2.
a. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
b. Click the Options tab.
c. Click Service Options.
d. Click Enable.
e. Enter an access code to enable online support. For an access code, contact your Philips

representative.
2. Do one of the following:

• At the top of the Q-Assistant desktop, click the Request Support tab.
• In the lower left corner of the Q-Assistant desktop, click Request Support.

3. Complete the fields in the Request Support form.
4. Click Request Service to send your support request to Philips.
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Viewing Support-Request History
If Request Support is enabled, you can view a history of your online-support requests.
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Request Support tab.
3. Click History to view the details of previous support requests.
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Q-Station Basics
The Q-Station software is designed to manage, view, and report image data acquired by
ultrasound systems. It is a DICOM viewer that provides an environment for review and
quantification of cardiovascular and general imaging ultrasound studies. You can manage study
data, review images, perform wall motion scoring, and make labeled as well as unlabeled
measurements in the Q-Station software. You can also create patient reports and export
patient data to DICOM archives, removable media, or network storage locations.

When you purchase Q-Apps, the Q-Station software integrates the QLAB software to provide
advanced quantification and includes the most clinically relevant QLAB software analysis results
in the report.

WARNING
United States federal law restricts this device to sale by or on the order of a physician.

NOTE
The Q-Station software is not intended for long-term storage and should only be used to store
patient data that you are currently investigating. Short-term storage is limited to a user-defined
amount of free space on the local hard drive, which can be susceptible to failure. To ensure
data security, patient data should also be stored on a secure storage device (a PACS).

NOTE
Your ability to analyze images depends on the quality of the image data you intend to analyze.
Image quality is dependent on a number of factors, including the quality and grayscale standard
display function (GSDF) calibration of the reviewing monitors, the ambient lighting in the
viewing environment, and the compression applied to the image when it is exported in DICOM
format. For more information on compression options available on the ultrasound system and
other export options that affect image quality, see the documentation that accompanies your
ultrasound system.
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NOTE
For accurate annotation of secondary captures and Q‑Station reports, ensure that the system
date and time settings are correct. For information about viewing and changing the system date
and time settings, see your operating system documentation.

The Q-Station software guides you through your workflow by using task-oriented activities.
Each activity is described in detail in the Help. The following activities are available:
• To manage patient data and to select studies for processing in other available activities, use

the Studies tab.
• To view patient data, use the View tab.
• To analyze images by using Q-Apps, use the QLAB option on the Studies tab or the View

tab.
• To create, edit, approve, and print reports about patient data, use the Report tab.
• To export patient data to DICOM archives and media (DICOM format) or to export in PC

format to your local drive or media, use the Export tab.

Security
The Q‑Station software uses the following security features to protect patient data from
unauthorized access:
• Computer security policy (optional in Setup.exe)
• Screen blanking
• Audit logging
• Secure remote access

For further details, contact your hospital IT administrator, and see Shared Roles for System and
Data Security, included on the User Information CD.

WARNING
You are solely responsible for security of all patient data on the Q-Station computer.
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CAUTION
If the Q-Station PC is part of a wireless network, use only secured wireless technologies. For
more information about network security, see Shared Roles for System and Data Security,
which is included on the User Information CD.

Logging On
If security features have been set up through the computer security policy option during
installation of the Q‑Station software, each user of the system is identified with a unique user
name. Each user name is assigned a password. User names and passwords are created during
installation of the Q‑Station software, or by your Hospital IT Administrator. For details about
creating user accounts, search the Windows Help for user accounts.

The user name of the user currently logged on is displayed on the Q‑Station message bar.

CAUTION
If access to the Q‑Station software is not restricted to authorized persons by your hospital’s
security policy, do not leave the software unattended while you are logged on. If you need to
leave the Q‑Station software unattended, lock it or log off.

CAUTION
Access to the Q‑Station software by users with administrative privileges, or by users with
sophisticated and malicious methods, cannot be restricted except by restricting physical
access to the workstation.

1. In the Windows Security panel, type your user name in the Name field.
2. Type your password in the Password field.
3. Click OK.
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Locking the Software
If you need to leave the Q‑Station software unattended for a period of time, but will return and
continue working, you can lock it to prevent unauthorized access to patient data while you are
away.
1. Press Ctrl+Alt+Delete to display the Windows Security panel.
2. Click Lock Computer.

You are not logged off, but the Q‑Station software is secured. The Log On panel is displayed.
Use your password to unlock the software and continue where you left off.

Logging Off
1. Press Ctrl+Alt+Delete to display the Windows Security panel.
2. Click Log Off.

Your work is saved and the Windows Security panel is displayed for the next user.

Keyboard Shortcuts
This section provides definitions of the Q-Station keyboard shortcuts.

General Keyboard Shortcuts
The following general keyboard shortcuts are available:

Shortcut Function

Break Play or pause

Ctrl+A Select all

Ctrl+C Copy

Ctrl+I Show or hide image information

Ctrl+P Print

Ctrl+R Reset image viewing settings

Ctrl+V Paste

Delete Delete
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Shortcut Function

Alt+F4 Exit

Spacebar Play or pause

F1 Help

F5 Refresh

F11 Full screen

Shift+F10 Open the shortcut menu

Image Viewer Keyboard Shortcuts
The following image viewer keyboard shortcuts are available:

Shortcut Function

R Show or hide the measurement results

Left Arrow Previous frame in a loop

Right Arrow Next frame in a loop

Up Arrow Increase frame rate

Down Arrow Decrease frame rate

Home First frame in a loop

End Last frame in a loop

Page Up Previous image in a study when viewing in one-
up mode, or previous four images when viewing
in four-up mode

Page Down Next page in a study when viewing in one-up
mode, or next four images when viewing in four-
up mode

Export Keyboard Shortcuts
The following export keyboard shortcuts are available:
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Shortcut Function

Ctrl+Right Arrow Add column

Ctrl+Left Arrow Remove column

Ctrl+Down Arrow Add row

Ctrl+Up Arrow Remove row

Common Elements
The following tools are available in all activities.

Menu Bar

The menu bar provides access to frequently used commands for performing tasks. Depending
on your current activity, some commands may be unavailable. Commands are described in the
section to which they apply.

Activity Bar

The activity bar provides access to each activity (View, Report, Export) with the focus on the
patient data selected in the Studies tab. If an activity is not available in your current situation,
the tab appears dimmed, and you cannot switch to that activity. You can close an activity and
return to the Studies tab by clicking Close on the File menu.

Main Toolbar

The main toolbar provides quick access to the tools most relevant to your current activity. Tools
found on the main toolbar are described in the procedures to which they apply.

Analysis Panel

The Analysis panel lists the available calculations and measurements, and the calculations and
measurements being performed. Controls in the Analysis panel are described in the procedures
to which they apply.
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Image Toolbar

The image toolbar provides quick access to the tools most relevant to the images displayed in
the image area. Tools found on the image toolbar are described in the procedures to which
they apply.

Patient Info Panel

The Patient Info panel is visible in activities beyond the Studies tab, and provides demographic
details of the current patient.

The Series tab of the Patient Info panel provides a pictorial index display of a thumbnail of each
image or report contained in the study.

You use the pictorial index to select images and reports for processing in available activities. In
the pictorial index, images and reports are grouped by study. Studies are separated by a
divider. Studies are grouped chronologically, with the most recent first.

Each image or report in the pictorial index is identified by a thumbnail, which provides
information about the image or report.

NOTE
Information may not always be available.

A status mark indicates that an image has been opened in the View tab during the current
viewing activity. Status marks are only available in the View tab.

To open an image or a report, double-click the thumbnail. Double-clicking an image thumbnail
opens the image on the View tab. Double-clicking a report thumbnail opens the report on the
Report tab.

Shortcut Menu

You can click items with the right mouse button (called "right-click") to see a shortcut menu
containing commands and tools relevant to the item.
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Data Type Icons
Icons on thumbnails indicate the data type of the image.

Data Type Icons

Icon Data Type

Image compatible with QLAB
software

Multi-frame loop

Messages and Notifications
The message bar provides feedback on the state of the system and notification of system
events. These messages are for your information only, providing an acknowledgment of jobs
that you have submitted or a status update on the progress of a job. System events are
displayed with an icon of the event in progress. The user name of the user currently logged on
is also shown in the message bar. To show or hide the message bar, select Message Bar on the
View menu.

Notifications provide more detailed information about a system event and are displayed in a
pop-up window just above the message bar. The severity of the notification is indicated by its
color.

Notification Types
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Job Viewer
The Job Viewer provides details of export, print, DICOM, removable media, and network jobs
that you have submitted to the system. You can open the Job Viewer at any time to check the
status of your jobs, or to modify a job.

Jobs are executed according to their priority. Concurrent jobs that have the same priority are
executed in the order that they were submitted. You can make jobs execute sooner by
increasing their priority in the Job Viewer.

Using the Job Viewer
1. To open the Job Viewer panel, select Job Viewer on the View menu.
2. Select a command and do any of the following:

• To disable a job, click .

• To enable a disabled job, click .

• To cancel a job, click .

• To abort a job, click .

• To delete a job, click .

• To resubmit a job, click .

• To increase the priority of a job, click .

• To decrease the priority of a job, click .

To filter the contents of the Job Viewer window, expand the  menu and select the type of
jobs you want to view.
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Full-Screen Mode
To maximize the display area, you can operate the Q‑Station software in full-screen mode to
hide the main toolbar, the activity bar, and the message bar. The menu bar remains visible to
provide access to commands. Commands for switching between the activities are available on
the Navigation menu, allowing you to continue with your workflow in full-screen mode.

To switch to full-screen mode, select Full Screen on the View menu or press F11. To exit full-
screen mode, press F11.

Q-Assistant
Q-Assistant is the configuration application for the Q‑Station software. This separate
application is installed when you install the Q‑Station software.

NOTE
To run Q-Assistant, you must be a member of the local Administrators group.

Use Q-Assistant to do the following:
• Back up and restore configuration settings and your license file (see “Backing Up

Configuration Settings” on page 69 and “Restoring Configuration Settings” on page 69).
• Establish a remote connection (see “Configuring Remote Services Connection Settings” on

page 29).
• Configure network settings (see “Checking Network Settings” on page 71).
• Configure DICOM settings for connections to ultrasound systems and PACS servers (see

“Adding DICOM Devices” on page 72 and “Editing DICOM Devices” on page 74).
• Update the license file by using the registration wizard (see “Manually Registering the

Software” on page 26).
• Select a storage location for Q‑Station reports (see “Specifying Data Storage Locations” on

page 67).
• Collect logs.
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Q-Setups
Q-Setups is the configuration application for the measurements and analysis features in the
Q‑Station software. This separate application is installed when you install the Q‑Station
software.

Use Q-Setups to do the following:
• Select measurement tools and analysis results for each analysis package (see “Tools and

Results Tab” on page 77).
• Create measurement or calculation labels and view their properties (see “Measurements

Tab” on page 80).
• Map unrecognized measurements imported from non-Philips ultrasound systems to a

defined, existing measurement label (see “SR Mapping” on page 59).
• Select the measurements that you want to generate, display, and add to the patient report

(see “Configuring Measurement Results” on page 78).
• Specify which measurements and calculations are included in each package (see

“Configuring the Calc List” on page 79).
• Reset the analysis packages to their original factory settings (see “Factory Settings Tab” on

page 84).

Q-Station Options
Besides the DICOM viewer features available in the Q-Station software, the QLAB
Cardiovascular 3D viewer and the QLAB General Imaging 3D viewer are standard with all
configurations. Other features are available as purchasable options. The types of options
available include connectivity capabilities and QLAB Q-Apps.

NOTE
Purchasable options can be used only on a single Q-Station installation.

NOTE
Some Q-Apps may be unavailable in some countries.
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The following licensed options are available for Q-Station software:
• Q-Station Base (required for all configurations; includes DICOM Export and DICOM Query/

Retrieve)
• Auto 2D Quantification (a2DQ) Q-App
• Auto Cardiac Motion Quantification (aCMQ) Q-App
• Cardiac Motion Quantification Stress (CMQ-Stress) Q-App
• Cardiac 3D Quantification (Cardiac 3DQ) Q-App
• Cardiac 3D Quantification Advanced (Cardiac 3DQ Advanced) Q-App
• Mitral Valve Navigator (MVN) Q-App
• Strain Quantification (SQ) Q-App
• Region of Interest Quantification (ROI) Q-App
• Intima Media Thickness (IMT) Q-App
• Cardiac Parametric Quantification (Cardiac PQ) Q-App
• MicroVascular Imaging (MVI) Q-App
• General Imaging 3D Quantification (GI3DQ) Q-App
• General Imaging Parametric Quantification (GIPQ) Q-App (This Q-App is unavailable in the

United States.)
• Elastography Analysis (EA) Q-App (This Q-App is only available in the United States.)
• Elastography Quantification (EQ) Q-App (This Q-App is unavailable in the United States.)
• Vascular Plaque Quantification (VPQ) Q-App
• Fetal Heart Navigator (FHN) Q-App

For more information on the QLAB Q-Apps, see the QLAB Help and the QLAB User Manual.

Viewing Installed Q-Station Options
1. On the Windows desktop, double-click the Q-Assistant icon to open Q-Assistant.
2. Click Options to see a list of the Q-Apps and optional features installed on your system.

Q-Station Compatibility
The following file formats created on Philips Ultrasound systems are incompatible with
Q‑Station software: DSR, TIFF, DEFF (data exchange file format), and ResearchLink.

In addition to clinical image data, Q-Station software also communicates with PACS from
various manufacturers.
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File Compatibility

Q-Station software can open files from any of the following ultrasound systems:
• ClearVue 650
• CX30
• CX50
• EPIQ series systems
• HD11 and HD11 XE
• HD15
• iE33
• iU22
• Sparq

Additional analysis capabilities are available when the images from those systems contain
Philips native data. (Native data is raw image data saved with an ultrasound image that enables
post-acquisition adjustments to the image.) Q-Station software also can open files from any
ultrasound system that can export patient studies in DICOM format.

PACS Compatibility

Q-Station software can query and retrieve patient lists and studies from any PACS that supports
standard DICOM Query/Retrieve capability. This is a purchasable Q-Station option.

Q-Station Language Support
The following languages are available for the Q-Station user interface and documentation:
• Chinese, Simplified
• Danish
• Dutch
• English
• French
• German
• Italian
• Japanese
• Norwegian
• Portuguese
• Spanish
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• Swedish

The following languages are available for the Q-Station documentation (however, the user
interface and the Help are provided in English):
• Chinese, Traditional
• Czech
• Finnish
• Greek
• Hungarian
• Polish
• Portuguese
• Romanian
• Russian
• Turkish
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Working with the Q-Station Software
This section guides you through procedures commonly used in working with patient study data
on the Q-Station software. These procedures include importing and exporting patient study
data, reviewing images, and performing advanced quantification.

For detailed information on the controls, features, and tasks mentioned here, as well as
information on additional tasks, see the Help.

To display the Help, click Help and then click Q-Station Help.

For instructions on using QLAB Q-Apps, click  while you are using a Q-App.

Studies
The Studies tab provides an overview of patient study data stored locally, and allows you to
access patient study data stored on remote data sources.

To open patient study data for processing, the data must reside in the local Studies database.
To add data to the Studies database, you must import patient study data from another source,
such as a CD/DVD drive, a USB storage device, a user-selectable repository, or a remote data
storage location. To delete one or more images from a study, right-click the selected thumbnail
or group of thumbnails, and then click Delete.

NOTE
The image Delete operation does not have an "undo" feature.

After importing patient study data into the Studies database, you can open the data for
processing. After processing, you should export the data to a DICOM archive.

NOTE
You can sort the studies list by clicking the heading of any column. You can reorganize columns
by dragging them to the preferred position.
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Data Panel
The Data panel displays data locations that are available to you. The panel is divided into two
sections: Local Data and Remote Data.
• Local Data provides access to the Studies data storage location, which is the database

where patient study information is stored on your workstation. The Local Data section also
provides access to studies stored on CD/DVD drives, USB storage devices, and one or more
user-selected locations on local or network disk drives.

• Remote Data provides access to data storage locations on workstations or a PACS
connected to your network. You can copy data from remote locations to work with it on
your local workstation. You can copy data to remote data storage locations for archiving.
If you are working with more than one local data location, you can right-click the location
you want to view and add it to the display as a new tab. To close a tab, right-click the tab
and select Close.

If you want additional display space, you can close the Data panel by clicking the X in the upper
right corner, or by clicking Data on the View menu. To reopen the Data panel, click Data on the
View menu again.

NOTE
For information about using data storage locations, see “Specifying Data Storage Locations” on
page 67.

NOTE
The Free Space indicator at the bottom of the Data panel compares the amount of unallocated
database space with the amount of free space on the hard drive and displays the lesser of those
values as an indicator of the amount of space available for storing data in the Studies database.

Retrieving Study Data from PACS/Archive
Study lists stored on a PACS/archive are retrieved by query.
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CAUTION
When retrieving patient data from a PACS/archive, you must formulate a specific query to
ensure that all relevant data is retrieved.

1. In the Data panel, click a Remote Data location.
2. Type or select search terms in the available query fields.

NOTE
Available query fields and the format in which you must enter data in the query fields depend
on the configuration of the selected PACS/archive. For example, many PACS require patient
names to be entered in uppercase text. For more information, contact the administrator of the
PACS/archive.

3. To reset the query form, click Clear.
4. To submit your query, click OK.

NOTE
You cannot perform processing tasks on study data displayed in a remote study list. To perform
further actions on the study data, import the data to the studies data location. Also, pictorial
representations of the images are labeled Archived, do not contain any imaging data, and may
not accurately represent the number of images in the study.

Transferring Studies Data to Your Workstation
1. In the Data panel, select the data location from which you want to transfer patient data.
2. Select the data you want to transfer:

• One or more images or reports from a single study
• One or more studies from the Studies list

3. Drag the selected data to the Studies data location.
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NOTE
If the selected data belongs to a patient that already exists in the destination location, the data
is automatically merged with the existing patient.

NOTE
You can also use the Copy and Paste commands to transfer data.

Archiving Data to a DICOM Archive
1. Select the data you want to archive:

• One or more images or reports from a single study
• One or more studies from a single patient
• One or more patients from a Patients list (all data for each patient is archived)

2. Drag the selected data to the destination DICOM archive in the Remote Data section of the
Data panel.

NOTE
If the selected data belongs to a patient that already exists in the destination location, the data
is automatically merged with the existing patient.

NOTE
You can also use the Copy and Paste commands to transfer data.

Setting CD/DVD Write Preferences
Before writing to a disc for the first time, set the CD/DVD write preferences. You can then use
the same settings each time you write patient data.
1. On the Tools menu, click Customize CD/DVD Write Preferences.
2. Configure the settings and then click Save.

 

 

 

 

 

 

 

 

 

 

 

Working with the Q-Station Software Studies

50 Q-Station User Manual 4535 617 35291



Writing a Disc Using Preferred Settings
Before writing a disc for the first time, set the CD/DVD write preferences. See “Setting CD/DVD
Write Preferences” on page 50.
1. Insert a blank disc in the CD/DVD writer.
2. Select studies data to write to disc.

3. On the main toolbar, click .

Viewing
Use the View tab to view and measure images, to play loops from stress echo and non-stress
echo studies, to select subloops, and to perform wall motion scoring on stress echo studies. You
can view both single-frame images and loops (a sequence of images).

NOTE
Q-Station software does not import the wall motion scoring information of studies that contain
existing wall motion scoring information.

The View tab incorporates the pictorial index, which you use to select images for viewing.
Images that are currently open for viewing are highlighted in blue in the pictorial index.

You can make adjustments to the displayed images by using tools provided on the View tab.
Menu commands and tools on the main toolbar affect all images. Tools on the image toolbar
affect only the image with which you are working.

The Q-Station software includes the Q-Vue application, a stand-alone DICOM viewer that you
can add to your exported DICOM images. The Q-Station software also includes optional viewing
capabilities for multimodality images. For more information about Q-Vue and multimodality
image viewing, see the Help.

Displaying the Image Toolbar
The image toolbar contains tools that let you adjust the view of an image, select subloops,
make basic labeled and unlabeled measurements, and annotate the image.

To display the image toolbar, click  on the upper right corner of the image.
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Image Toolbar Controls
Control Description

Selects the image.

Scrolls the image.

Adjusts contrast and brightness.

Zooms the image.

Pans the image.

Plays a loop. Available only when Sync Mode is set to
Free Run.

Pauses a loop. Available only when Sync Mode is set to
Free Run.

Increases cineloop playback frame rate.

Decreases cineloop playback frame rate.

Plays the cineloop at the acquisition frame rate.
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Control Description

Displays subloops (stress echo images only).

Displays the next subloop (stress echo images only).

Displays the previous subloop (stress echo images only).

Sets a subloop as the preferred loop (stress echo
images only).

Enables you to draw an arrow with an annotation.

Resets the image viewing settings.

Captures the image and appends it to the study. (This
control is available when a loop is playing; however, it
only captures and appends the frame that was active at
the time of the mouse click.)

Marks the image for inclusion in the report.

Displays image information.
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Performing Wall Motion Scoring

NOTE
Wall motion scoring is allowed only on protocols with eight or fewer stages.

1. On the main toolbar, click .
2. Drag the slider at the top of the window to indicate the stage you are scoring. If Display

Stages is selected on the Display Mode menu, Q-Station displays the corresponding stage in
the image viewer.

3. Click the view icons to see the wall segments from different perspectives. If Display Views is
selected on the Display Mode menu, Q-Station displays the corresponding view in the
image viewer.

4. Do one of the following:
• If all wall segments are normal, click All Normal.
• Click the wall segment in the left-ventricle graphic or in the bull's eye, and click the

wall score for the segment (scores are synchronized between the graphic and the bull's
eye).

5. Before scoring the next stage, click Save to store your input for the current stage.
6. Repeat step 2 through step 5 for each stage. To apply the scores from the previous stage to

the current stage, click Carry Over.

Annotating an Image
You can add an arrow with a text box to an image. Annotations can be added only to single-
frame images or to frames with within a loop.

1. To display the image toolbar, click .

2. Click .
3. Click on the image to place the arrow, and click again to display the text box.
4. Type the annotation in the text box and click to complete the annotation.
5. To edit the annotation, put the cursor in the text box and type changes.
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Capturing an Image
When you capture an image, it is appended to the study as a JPEG-compressed DICOM image.

The  icon appears on captured images in the pictorial index.

1. To display the image toolbar, click .

2. Click .

QLAB Q-Apps for Analyzing Images
Q-Station can include the QLAB Advanced Quantification Software as a purchasable option. The
QLAB software is a tool that provides several Q-Apps to perform advanced quantification.

For a list of Q-Apps that the Q-Station software supports, see “Q-Station Options” on page 43.

WARNING
The heart rate (HR) in the Q-Station Report and the HR that is included with the bull's eye
diagrams exported from the QLAB aCMQ and CMQ-Stress Q-Apps have different clinical
meanings. The HR in the exported bull's-eye diagrams is an averaged HR from three views,
and the individual HR for each view is not from DICOM.

Analyzing Images with QLAB Q-Apps
From the Studies tab, you can load an image into a QLAB Q-App for analysis. For information
about working with the Studies tab, see “Studies” on page 47.
1. From the Studies tab, select an image.
2. From the View tab, do one of the following:

• Right-click the image, and then click Q-Apps.
• Click the square in the lower right corner of the image (a check mark appears in the

square ), and then click .

• Click  on the image.
3. Click the name of the Q-App that you want to use.
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4. For instructions on using the QLAB software, click  while you are using a Q-App.

Opening Multiple Images in a Q-App
Some Q-Apps, such as a2DQ, aCMQ, and CMQ-Stress, allow you to open multiple images at the
same time.

Opening Multiple Images from the Studies Tab
1. On the Studies tab, in the list of images on the Series tab, Ctrl+click all the images you want

to open.
2. Right-click one of the selected images, and then click Analyze With.
3. Click a Q-App name.

Opening Multiple Images from the View Tab
1. On the View tab, in the list of images in the left pane, Ctrl+click all the images you want to

open.

2. To select all of the images, click  on the main toolbar.

3. Click  on the main toolbar, and then click a Q-App name.

Reports
Patient reports contain the measurements and quantification results that were completed in
the patient study as well as images that you specifically add.

A patient report generates automatically while you conduct a study that includes both labeled
measurements and image acquisitions. To access the report, click the Report tab.

Viewing Reports
Draft reports are displayed automatically in the Report tab.

To view approved reports:
1. In the Studies tab, select an examination that has an approved report.
2. Click the Report tab.

3. Click .
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All approved reports for the selected patient are displayed in the Approved Reports table in
the control panel.

4. Select one or several reports in the Approved Reports table.
Each selected report is displayed as a PDF file in a dedicated tab in the main display area.

Alternately, you can view an approved report by double-clicking the report thumbnail in the
pictorial index on the View tab or the Studies tab.

Editing a Report
The department name and institution name that appear in the report are specified when you
use the Q-Assistant System Management tools to configure Q-Station. For more information,
see “System Management”.

For information on editing measurements in a report, see the Help.
1. In the Studies tab, select an examination.
2. Click the Report tab.

3. Click .
4. Enter a title for the report in the Title field in the control panel.
5. Under Advanced Analysis, select one or more of the following image types to include in the

report, as appropriate:
• CMQ-Stress Bulls Eye
• WMS Bulls Eye
• WMS Anatomic

NOTE
If you select CMQ-Stress Bulls Eye, only the WMS Bulls Eye can be included in the report.
(WMS Anatomic is unavailable.)

6. Under Advanced Analysis, select one or more of the stages to include in the report.
The report supports stress studies with up to eight stages. The stages are named as they
were during the exam acquisition.

7. Under Findings, select any applicable codes to include findings statements in the report.
A Findings section is added to the report and the statements associated with the selected
codes are entered.
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8. Enter text in the draft report, using the standard word-processing tools (Microsoft Word) in
the main display area.

9. Click  to save the draft report as work in progress.

Setting Electronic Signatures on Reports
The user name (electronic signature) that appears in the footer of the report is set or edited by
changing the user name that defines the active user account.
1. Open the Windows User Accounts dialog box. For more information, search the Windows

Help for user accounts overview.
2. Select the user account that you want to edit.
3. Edit the User Name that appears in the account.
4. Restart the computer to reset the account information. All new reports will display the new

user name as the report's electronic signature. Existing reports will continue to display the
original electronic signature name.

Approving a Report
1. Open the draft report that you want to approve.

2. Click .
The report is converted to a DICOM Encapsulated PDF file and is moved from the Edit task
to the table of approved reports in the View task.

Printing a Report
1. Select the report that you want to print in the Approved Reports table, or if the report is

already displayed, ensure its tab is selected.

2. Click .
The report is printed to the workstation's default paper printer.

Custom Report Templates
You can create report templates to customize the sections of your Q-Station reports.

The following lookup fields are available for adding to your custom report templates:
• Patient Name
• Patient ID
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• Accession Number
• Date of Birth
• Patient's Age
• Gender
• Study Data
• Referring Physician's Name
• Institution Name
• Institution Address
• Department Name
• Patient's Size
• Patient's Weight
• Study Description
• Operator's Name

NOTE
For guidelines and detailed instructions on creating and editing custom report templates, see
the Help.

SR Mapping
With Q-Station, you can import studies and view images from non-Philips ultrasound systems.
However, some of the measurement data, specifically DICOM structured report (SR) entries,
from these imported studies may not be recognized by Q-Station. As a result, the reports you
create from these imported studies will not contain all of the available data. You can use SR
Mapping in the Q-Setups utility to map unrecognized measurements to existing Q-Station
measurement labels. You can also unmap and remap the imported measurements.

NOTE
Changes you make with the Q-Setups utility do not take effect until you stop and restart the
Q‑Station software.
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SR Mapping is designed to simplify the mapping process. For example, you can:
• Double-click an item in either list to view or hide details about that item.

• Click  on the right side of either list to display the filter feature. Type your text in the
available field, and then click Filter. To remove filtering, clear the text in the available field,
and click Filter again.

• Click a column header to sort either list by that column's attributes.
• Sort the list of unmapped measurements by selecting an analysis package.

Mapping Imported Measurements
You can map unrecognized measurements from a study imported from a non-Philips ultrasound
system.
1. Import and open the study.
2. Click Report.
3. Click Tools, and then click Q-Setups SR Mapping while viewing the generated report.
4. After the Q-Setups utility opens, select an application (Adult Echo, Vascular, or Pediatric) to

sort the list to match the analysis package that you are using.
5. Make sure Show UnMapped is selected.
6. Click an unmapped measurement from the DICOM SR Entry list.
7. Browse the list of System defined measurements and calculations for a matching label and

concept.
8. Click the matching measurement label when you find it, and then click Map.
9. Repeat steps 5 through 7 with each item in the DICOM SR Entry list.
10. Click Close when the mapping is complete.
11. Exit and restart Q-Station to apply the new mapping.

Remapping Imported Measurements
You can change the mapping of measurements you defined previously. Measurements that
were mapped automatically during the study import cannot be remapped.
1. Open the study that contains the measurements that you want to remap.
2. Click Report.
3. Click Tools, and then click Q-Setups SR Mapping while viewing the generated report.
4. After the Q-Setups utility opens, select an application (Adult Echo, Vascular, or Pediatric) to

sort the list to match the analysis package that you are using.
5. Deselect Show UnMapped, and then select Show Mapped.
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Items that have been mapped automatically by the system appear dimmed.
6. Click the measurement to be remapped in the DICOM SR Entry list, and then click UnMap.
7. Browse the bottom list of System defined measurements and calculations for a new

matching label and concept.
8. Click the matching measurement label when you find it, and then click Map.
9. Click Close when the remapping is complete.
10. Exit and restart Q-Station to apply your changes.

Unmapping Imported Measurements
You can delete the mapping of measurements you defined previously. Measurements that
were mapped automatically during the study import cannot be unmapped.
1. Open the study that contains the measurements that you want to unmap.
2. Click Report.
3. Click Tools, and then click Q-Setups SR Mapping while viewing the generated report.
4. After the Q-Setups utility opens, select an application (Adult Echo, Vascular, or Pediatric) to

sort the list to match the analysis package that you are using.
5. Deselect Show UnMapped, and then select Show Mapped.

Items that have been mapped automatically by the system appear dimmed.
6. Click the measurement to be unmapped in the DICOM SR Entry list, and then click UnMap.
7. Click Close when the unmapping is complete.
8. Exit and restart Q-Station to apply your changes.

Exporting
The Export tab displays images from the selected study in the image viewer. Also displayed is
the Export Settings panel, which you use to configure and send the export job.

To collapse or expand the Export Settings panel, click its title bar.

NOTE
When exporting to removable media, Philips recommends that you scan the media for viruses
before use. Also, only use media from trusted sources.
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Displaying the Export Toolbar
The export toolbar contains tools that let you adjust the view of an image, select subloops, and
anonymize the image.

To display the export toolbar, click  on the upper right corner of the image.

Export Toolbar Controls
Control Control Description

Selects the image

Scrolls the image

Adjusts contrast and brightness

Zooms the image

Pans the image

Selects the format in which images are displayed

Selects the previous frame

Selects the next frame

Plays a loop.
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Control Control Description
Stops playback of a loop.

Decreases the frame rate of a loop.

Increases the frame rate of a loop.

Defines an area of the display for an anonymization template.

Saves an anonymization template.

Applies an anonymization template.

Patient Data Export
You can export images in either DICOM format or PC format.

If you use anonymization when exporting patient data to removable media or a Windows
folder, certain patient attributes are replaced with anonymized values.

WARNING
When exporting data, the presentation state of images at the time of export is preserved in
the exported data. You should be aware that important diagnostic information, for example
annotations, may not be visible when viewing the exported images.

CAUTION
Exported data is not anonymized by default. If data is exported to a system or storage device
that is not protected by password or other method, it is accessible by all clinical users. It is
your responsibility to ensure that patient privacy is not compromised at the export location.
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Exporting Data in DICOM Format

CAUTION
To prevent unauthorized persons from removing the media when an export task finishes, you
must not leave the system unattended while an export task is in progress. Alternatively, the
system must be accessible by authorized persons only.

CAUTION
Exporting to removable media should be considered as temporary storage only, and should
not be considered a long-term backup solution.

CAUTION
Objects that are not supported by a DICOM PACS or archive may be bypassed during export
to that PACS. Objects that may be unsupported include DICOM Encapsulated PDF files, and,
with older PACS, DICOM Structured Report. To alleviate this issue, deselect SR options in the
Advanced Settings area for the PACS DICOM device in DICOM Settings on the Network/
DICOM tab of the Q‑Assistant configuration utility.

CAUTION
Although exported DICOM information can be anonymized, there is no mask applied to
images to obscure the patient data that may be visible in the images.

NOTE
You cannot remove native data from an image to reduce file size prior to export.

1. Select one or more loops or single-frame images from a single study.

NOTE
To export the entire study, click Select All.
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2. In the Export Settings panel, click the DICOM tab.
3. Do one of the following:

• To export patient data in DICOM format to a DICOM archive, a CD, a DVD, or a USB
drive, select a destination on the Destination menu.

• To export patient data in DICOM format to a Windows folder, click  and select a
folder on the workstation, CD, DVD, or USB drive.

4. To export the stand-alone DICOM Viewer application with the patient data, select Include
DICOM Viewer.

5. To make patient data anonymous, select Anonymize. If you want to change the default

anonymization name after selecting Anonymize, click .

NOTE
To apply the anonymization preset to every study image, click Select All.

6. Click Export.

Saving Images
1. In the image viewer, select the images that you want to save. You can select one or more

images at a time.
2. On the File menu, click Save Image As.
3. Select a quality setting.
4. To change the file name, type a new name in the File Name field.

By default, the patient name is used as the file name and images are saved as JPEG files
(.jpg). However, you can select other formats from the Image Format menu.

5. To change the destination, do one of the following:
• Select a previously used destination on the Destination menu.

• Click  and select an available destination (Windows folder on the workstation or
USB drive).
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NOTE
When saving data in PC format, you can save only to Windows destinations and not to DICOM
nodes.

6. Click OK.

Saving a Loop as a Movie
1. Open a loop and select its tab on the image viewer.
2. On the File menu, click Save Movie As.
3. Select a quality setting.
4. To change the default file name, type a new file name in the File Name field. By default, the

patient name is used as the file name. Movies are saved as AVI files (.avi).
5. To change the destination, do one of the following:

• Select a previously used destination on the Destination menu.

• Click  and select an available destination (Windows folder on the workstation or
USB drive).

NOTE
When saving data in PC format, you can save only to Windows destinations and not to DICOM
nodes.

6. Click OK.
The movie is saved as it appears in the image viewer.
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System Management
The System Management tab in Q-Assistant lets you specify system information such as audit
server and language settings, specify locations in which to store Q‑Station data, and back up
and restore the Q‑Station license file and configuration settings.

Specifying System Information
The Q-Assistant software displays your Q-Station serial number, which it reads from the license
file, in the System Information area of the System Management tab.
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. In Q-Assistant, click the System Management tab.
3. Click System Information.
4. Do any of the following:

• Type information in Institution Name and Department.
• Select the language in which you want to run the Q-Station software and the

Q‑Assistant software from the Language menu.
• If your site uses an audit server, enter its IP Address, Host Name, and Port Number,

and select the appropriate Network Protocol.
5. Click Save.

Data Locations
In the Media/Store section of the Q-Assistant System Management tab, you can specify local
folders, network shared storage areas, and local storage devices as Q‑Station data locations.

Specifying Data Storage Locations
The storage directories that you specify in Q‑Station Data Locations appear in the Local Data
area of the Q‑Station Studies tab. The directories you specify there are different from the local
patient database, the location of which you select when you install the Q-Station software.
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. In Q-Assistant, click the System Management tab.
3. Click Media/Store.
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4. To add a directory for Q‑Station data storage, in the Q‑Station Data Locations panel, click
Add and then browse to a local directory or network shared storage area and click OK.

5. Do one of the following:
• To activate the new storage locations or local storage devices immediately, click

Activate Now.
When you activate new storage locations or local storage devices, Q-Assistant exits
and then restarts.

• To specify additional data locations or local storage devices and activate the
directories later when prompted by Q-Assistant, click Activate Later.

6. To add and activate additional data locations, repeat steps 4 and 5.
7. To add a USB drive as a local storage device, connect the USB drive to a USB port on the

Q‑Station computer.

NOTE
FAT-formatted and NTFS-formatted USB drives are supported for Q‑Station data locations.

8. To configure a CD/DVD drive or a USB drive as a local storage device, in the Q‑Station Local
Devices panel, select the drive letters that correspond to the CD/DVD and USB drives on
the Q‑Station computer.

9. If the selected CD/DVD drive is read/write, select R/W.
10. Click Save.
11. When prompted, click Activate Now.

When you activate new storage locations or local storage devices, Q-Assistant exits and
then restarts.

NOTE
If the Q‑Station software is open when the Q-Assistant software restarts, the Q‑Station
software exits, and you must manually restart it.
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Backing Up Configuration Settings
You can back up the Q-Station configuration settings and license file in Q-Assistant.
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the System Management tab.
3. Click Backup/Restore.
4. Select Backup To.
5. Click Browse and select a location to which you want to back up the data.
6. To start the backup, click Backup. When the backup is complete, a notification message

appears.

Restoring Configuration Settings
In the Q-Assistant software, you can restore the Q-Station configuration settings and license file
from a backup location.

CAUTION
The Q-Station software does not support transferring configuration settings from one
Q‑Station computer to another. Restore configuration settings only on the Q‑Station
computer from which they were backed up.

1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the System Management tab.
3. Click Backup/Restore.
4. Select Restore From.
5. Click Browse and select the location from which you want to restore the data.
6. Select the data that you want to restore. You can select Configuration Repository, License

File, or both.
7. Click Restore.

When the restoration is complete, a notification message appears, and Q-Assistant restarts.
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Importing Configuration Settings
You can import configuration settings with the Q-Assistant utility. However, if you attempt to
import analysis settings that include a measurement or a calculation with a name that is already
stored on the system, you will be unable to append the imported settings. The system allows
you to import the settings only by overwriting the measurements and calculations (select
Overwrite Meas and Calc? in the Import Analysis Setups dialog box). This is intended to
prevent the unintentional loss of identically named settings on the system. If you do not want
to import all settings and overwrite the existing settings, avoid using duplicate names, or create
a DVD or a CD that contains only the settings you want to import. To exit the Import Analysis
Setups dialog box without importing, click Close Setup.
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Network and DICOM Settings
You can use the Q-Assistant software to connect the Q-Station software to ultrasound systems
and PACS. For a list of settings required for configuring Q-Station network and DICOM settings,
see “Network Requirements for Configuring the Q-Station Computer” on page 17.

NOTE
Q-Station software supports the DICOM Storage Commit service, which is used to confirm that
a study has been committed to permanent storage on a PACS. This confirmation ensures that it
is safe to delete the local copy of the study. When the Q-Station software receives this
confirmation, it flags the local copy of the study for deletion by the automatic cleanup service.

The Q-Station software supports any of the following connected workflows:
• If you do not archive studies to a PACS, you can connect an ultrasound system directly to a

Q‑Station computer, obtain data from the ultrasound system for analysis in the Q-Station
software, and then generate a report.

• If your PACS does not support storage of native data from the ultrasound system, you can
connect an ultrasound system directly to a Q‑Station computer, obtain native data from the
ultrasound system for analysis in the Q-Station software, and then archive the data to a
PACS without including native data. (Native data is raw image data saved with an
ultrasound image that enables post-acquisition adjustments to the image.) You can
configure this workflow in the Q‑Assistant software by deselecting the Native option for
Archive in the Advanced Settings area of the PACS Device in DICOM Settings dialog box.

• If the ultrasound systems at your institution are configured to send data to a PACS, you can
query the PACS to obtain a list of patients and studies, request that the PACS send the
Q‑Station computer a study for analysis, and then archive the data back to the PACS.

Checking Network Settings
You can view the Windows network settings for the computer on which the Q-Station software
is installed in the Network Settings area of the Network/DICOM tab in the Q-Assistant
software.
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CAUTION
If the Q-Station PC is part of a wireless network, use only secured wireless technologies. For
more information about network security, see Shared Roles for System and Data Security,
which is included on the User Information CD.

1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Network/DICOM tab.
3. Click Network Settings.
4. If your computer has more than one network card, select the appropriate card from the

Select Network Card menu.
5. Click Network Connections to open the Windows Network Connections control panel and

view settings for your network connection.
6. Do either of the following:

• To see detailed information about the network settings, click IPConfig/All.
• To release and then renew the network connection, click IPConfig/Release and then

click IPConfig/Renew.
7. To check the connection status of a server on the network, type the IP address of the

computer in the IP Address field and click Ping.

Adding DICOM Devices
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Network/DICOM tab.
3. Click DICOM Settings.
4. Enter the Q-Station AE title and port number in the AE Title and Port Number fields, and

then click Save.
5. Click Add.
6. In the Add DICOM Device dialog box, select a device type from the Device Type menu.
7. Enter a device name, an AE title, an IP address, and a port number for the device to which

you want to connect.
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NOTE
Each device must have a unique name. Philips recommends entering an easily recognized name
for the device that includes the function of the device. For example, "iSite - Store" or "iSite -
Commit."

NOTE
If you are connecting to an ultrasound system that has a dynamic IP address, the IP address you
enter is used only when you test the connection to the ultrasound system. The ultrasound
system can still send studies to the Q-Station software, even if the IP address changes.

NOTE
An ultrasound system that uses DICOM Query/Retrieve or DICOM Storage Commit must have a
static IP address.

NOTE
If the Q-Station computer sends data to any DICOM destination, the destination and the
Q‑Station computer both require a static IP address.

8. If you are adding a PACS, click Advanced Settings and do the following:
a. Select the functions supported by the PACS: Archive, Query/Retrieve, or Send. Some

PACS use the same AE title and port number for all three functions. If the PACS to
which you are connecting uses a different AE title or port number for different
functions, use the Add DICOM Device dialog box to add a separate device connection
for each function.

b. If you selected the Archive function, select the optional data types to be sent (still
images and loops are always archived): Native and SR. You can ask your network or
PACS administrator to determine if your PACS supports native data.

c. Only if your network or PACS administrator requests it, change the Association (Artim)
Timeout and a Storage Commit Max. Reply Waiting Time. The default settings are
suitable for most PACS.

d. Click OK.
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9. For each Storage Commit Device you are connecting to, select the following in the Storage
Commit Association section of the DICOM Settings dialog box:
• Click PACS Device, and then select the PACS name.
• Click Storage Commit Device, and then select the name of the device that performs

the storage commit function.
10. Click Save.
11. When prompted, do one of the following:

• To activate the new devices immediately, click Activate Now.
When you activate new devices, Q-Assistant exits and then restarts.

• To perform additional Q-Assistant tasks before activating the devices, click Activate
Later.

NOTE
If the Q‑Station software is open when the Q-Assistant software restarts, the Q‑Station
software exits, and you must manually restart it.

Editing DICOM Devices
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Network/DICOM tab.
3. Click DICOM Settings.
4. Select the DICOM device that you want to edit, and click Edit.
5. Make changes in the Edit DICOM Device dialog box.
6. If you are editing a PACS, click Advanced Settings to make changes in the Advanced

Settings dialog box.
7. Click Save.
8. When prompted, do one of the following:

• To activate the new devices immediately, click Activate Now.
When you activate new devices, Q-Assistant exits and then restarts.

• To perform additional Q-Assistant tasks before activating the devices, click Activate
Later.
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NOTE
If the Q‑Station software is open when the Q-Assistant software restarts, the Q‑Station
software exits, and you must manually restart it.

Deleting DICOM Devices
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Network/DICOM tab.
3. Click DICOM Settings.
4. Select the DICOM device that you want to delete and click Delete.
5. In the Delete DICOM Device dialog box, click Yes.
6. Click Activate Now to complete the deletion and restart the Q-Assistant software.

NOTE
If the Q‑Station software is open when the Q-Assistant software restarts, the Q‑Station
software exits, and you must manually restart it.

Testing DICOM Devices
1. To start Q-Assistant, double-click the Q-Assistant icon on your desktop.
2. Click the Network/DICOM tab.
3. Click DICOM Settings.
4. Select the DICOM device that you want to test, and click Verify.

Verification may require up to 1 minute.
Q-Assistant displays the results of a DICOM test (DICOM Verify and TCP/IP Ping) in the
Verify column and in the Verification Results area of the DICOM Services Configuration
dialog box.
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Analysis Configuration
You can use the Q-Setups utility to configure each of the available analysis packages, or to
create one or more custom analysis packages.

To view or modify the configuration of the analysis packages, click Analysis on the left panel.

For the available analysis packages, Q-Setups has the following configuration tabs:
• In the Tools and Results tab, you can specify which measurement tools are included in each

package and which results each tool will produce.
• In the Calc List tab, you can specify which measurements and calculations are displayed in

the Analysis panel for each package.
• In the Measurements tab, you can create or view measurement labels and their properties.
• In the Derived Calcs tab, you can create or view calculation labels and their properties.
• In the Report Meas/Calc Config tab, you can specify which measurements and calculations

are included in the patient report by default. This tab is unavailable for the General analysis
package.

• In the Factory Settings tab, you can reset the analysis packages to their factory-default
settings.

NOTE
Changes you make with the Q-Setups utility do not take effect until you exit and restart the
Q‑Station software.

Tools and Results Tab
In the Tools and Results tab, you can configure the choice of results for the measurement tools.
For the Adult Echo and the Pediatric Echo analysis packages, you can choose which method to
use for Simpson's measurements. In the Vascular and the General analysis packages, you can
also choose to hide or show the Doppler negative sign.
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Configuring Measurement Results
You can select the measurements that you want the "measure-then-label" tools to generate,
display, and add to the patient report. Each analysis package provides a different set of tools,
although many of the tools are shared. Each tool category is allowed a maximum of eight
selections.
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the tab for the analysis package you want to configure.
4. Click the Tools and Results tab.
5. Configure the measurement results as follows:

• Select the measurement results you want to generate, display, and add to the patient
report.

• Deselect the measurement results you do not want to generate, display, and add to
the patient report.

6. Click Close to exit Q-Setups.

Hiding the Doppler Velocity Minus Sign
The option to hide the Doppler velocity minus sign is available in the General and Vascular
analysis packages.

NOTE
When Hide Doppler Velocity Minus Sign is enabled, the sign value, whether visible or not, is
still considered in calculations performed with the reported value.

NOTE
If you do not want to export a negative Doppler value to the patient report, select the
(Max(Abs)) option for the Doppler measurement selector. For information about setting a
measurement selector, see the Help.

1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
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3. Click the Tools and Results tab.
4. Select the analysis package you want to configure (General or Vascular).
5. Under Hide Doppler Velocity Minus Sign, select On.
6. Click Close to exit Q-Setups.

Selecting a Measuring Tool for the Simpson's Method
This procedure applies to the Adult Echo analysis package only.
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the Tools and Results tab.
4. For the Simpson's method, select one of the following:

• Manual Trace: allows you to use the trackball to draw the outline of the left ventricle
and set the axis.

• 3-Point-Template: lets you set three caliper points and automatically connects those
points, allowing you to adjust the shape as needed. This is the default setting.

Calc List Tab
In the Calc List tab, you can specify which measurements and calculations are included in each
package.

Configuring the Calc List
The Calc List settings allow you to configure the measurements and calculations for each
supported imaging mode in each collection and each group. For more information about
measurement collections and groups, see the Help.

You can group measurements and calculations for each mode and collection available for the
selected analysis package.
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Select the analysis package you want to configure.
4. Click the Calc List tab.
5. Select the items that you want to configure from the Master List menu.

The Master List menu is populated to reflect the analysis package that you selected.
6. To add a measurement or a calculation label to a list:
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a. Select the label in the Master List.
b. Click either the Measurements list or the Calc List list to the left of the Master List.

c. Click . The label appears dimmed in the Master List and is added to the
Measurements list or the Calc List list.

7. To remove a measurement or calculation from a list:
a. Select the label in the Measurements list or the Calc List list.

b. Click . The label is removed from the Measurements list or the Calc List list and
is restored to the Master List.

NOTE
When adding a measurement to a group, you must highlight the group title in the
Measurements list.

Measurements Tab
In the Measurements tab, you can view, copy, and edit system-defined measurement labels,
groups, and collections. You also can create, view, edit, and delete customized measurement
labels, groups, and collections.

WARNING
The user is solely responsible for custom measurements and calculations and for the accuracy
of elements entered into the equations.

NOTE
You cannot delete system-defined measurement labels, groups, or collections.

Creating New Measurement Labels
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
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3. Click the tab for the analysis package you want.
4. Click the Measurements tab.
5. Click New.
6. On the left side of the display, select the list to which you want to add a new label.
7. For collections, groups, and measurements, type a new name in the Label field.
8. For measurements only, select a tool from the Tool menu and a selector from the Selector

menu. The tool selection determines which results become available for selection.
9. Select the results that you want the selected tool to generate.
10. For each selected result, select its Unit and Precision of measurement from the menus.
11. Click Save. The new label appears in the list with an asterisk (*) to indicate that it is a

custom label.

Copying Measurement Labels

NOTE
You can copy system-defined measurement labels only.

1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the tab for the analysis package you want.
4. Click the Measurements tab.
5. Select a measurement label from the list.
6. Click Copy.
7. Type a new name for the label in the Label field.
8. Make any other necessary changes in the Properties section of the tab.
9. Click Save.

Editing Measurement Labels
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the tab for the analysis package you want.
4. Click the Measurements tab.
5. Select a collection, a group, or a measurement label from the list.
6. Click Edit.
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7. Make changes as needed in the Properties section of the tab.
8. Click Save.

Deleting Custom Measurement Labels
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the tab for the analysis package you want.
4. Click the Measurements tab.
5. Select a custom collection, a custom group, or a custom measurement label from the list.

Custom labels include an asterisk (*).
6. Click Delete.
7. Click Yes to confirm the deletion.

Derived Calcs Tab
In the Derived Calcs tab, you can create or view calculation labels and their properties by using
a page-by-page automated approach for creating calculation labels, including custom
equations. This approach also allows you to copy and edit existing calculation labels and to
delete those you have created.

WARNING
The user is solely responsible for custom measurements and calculations and for the accuracy
of elements entered into the equations.

Viewing a Calculation Label
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the tab for the analysis package you want.
4. Click the Derived Calcs tab.
5. In the Calc List, select a calculation label. Custom labels include an asterisk (*).
6. Observe the following information about the selected calculation label:

• Calc Label: Name of the derived calculation label.
• Calc Equation: Formula of measurements or calculations for deriving a calculation.
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• Calc Unit: Unit of measure for the calculation result.
• Precision: Output precision of the calculation.

Creating, Copying, or Editing a Calculation Label
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the tab for the analysis package you want.
4. Click the Derived Calcs tab.
5. Click New, Copy, or Edit. A sequence of up to three displays guides you through the

procedure, depending on the task and whether the label is custom or system-provided. For
example, you can configure whether system-provided calculation labels appear in the
results and where they appear in the report.

6. Follow the instructions for each display.

Creating a Valid Calculation Equation

For new calculation labels, you are prompted to create a valid calculation equation in the
second display.
1. Enter the terms of the equation by any combination of the following methods:

• Click the simulated numeric keypad to enter mathematical functions.
• Select a calculation from the Calculation to Insert menu, and then click Insert Calc.
• Select a measurement, a result, and a unit from the Measurement to Insert menu, and

then click Insert Meas.
• Type measurements and calculations of your design. The format for a measurement is

[measurement.subresult "unit"]. The format for a calculation is [calculation "unit"].
Do not forget to type the brackets. These formats are the same as for inserted
measurements and calculations.

2. Type or select an output unit of measure for the calculation from the Enter or Select a Unit
menu.

3. Select an output precision value for the calculation from the Select a Precision menu.
4. Click Next or Finish.

Deleting a Custom Calculation Label
1. To start Q-Setups, double-click the Q-Setups icon on your desktop.
2. In the left panel, click Analysis.
3. Click the tab for the analysis package you want.
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4. Click the Derived Calcs tab.
5. Select a custom calculation label from the list. Custom labels include an asterisk (*).
6. Click Delete.
7. Click Yes to confirm the deletion.

Report Meas/Calc Config Tab
In the Report Meas/Calc Config tab, you can specify how measurements and calculations are
displayed in the report.

For more information, see “Custom Report Templates” on page 58.

Factory Settings Tab
The Factory Settings tab in the Q-Setups utility allows you to restore the analysis package
configuration to its original factory settings. You can choose to retain or overwrite all user-
defined measurements and calculations.
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changing settings, 21

settings, default values, 21

Configuration settings

backing up, 69

importing, 70

restoring, 69

Controls

activity bar, 38

export toolbar, 62

image toolbar icons, 52

main toolbar, 38

menu bar, 38

viewing, 51

Conventions

user information, 11

Copying calculation labels, 83

Custom calculation labels, 80, 83

Custom label, deleting, 82

Custom measurement labels, 80, 81

Customer comments, 12

Customer service, 12

D

Data locations, 67

Data panel, 48

Data storage locations, 67

Deleting

calculation labels, 83

DICOM devices, 75

measurement labels, 82

Derived calculations, 82

DICOM

archiving study data, 50

DICOM devices

adding, 72

deleting, 75

editing, 74
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testing, 75

DICOM format

exporting data, 64

DICOM settings, 71

Doppler velocity, hiding minus sign, 78

Drives, assigning, 67

E

EA

loading images, 55

Editing

calculation label, 83

DICOM devices, 74

measurement labels, 81

reports, 57

Electronic signatures, 58

EQ

loading images, 55

Export Settings panel, 61

Export tab, 61

Export toolbar, 62

displaying, 62

Exporting

DICOM format, 63, 64

patient data, 63

PC format, 63

F

FHN

loading images, 55

File compatibility, 44

G

GI3DQ

loading images, 55

GIPQ

loading images, 55

H

Help, 10

Hiding patient data

during export, 64

History, support, 32

I

Image quality, 33

Image toolbar

displaying, 51

Images

a2DQ, 55

aCMQ, 55

acquiring, 55

analyzing, 55

annotating, 54

capturing, 55
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Cardiac 3DQ, 55

Cardiac 3DQ Advanced, 55

Cardiac PQ, 55

CMQ-Stress, 55

data type icons, 40

displaying the toolbar, 51

EA, 55

EQ, 55

FHN, 55

GI3DQ, 55

GIPQ, 55

IMT, 55

loading, 55

MVI, 55

MVN, 55

pictorial index, 40

ROI, 55

saving in PC format, 65

SQ, 55

toolbar control icons, 52

viewing, 51

VPQ, 55

Importing configuration settings, 70

IMT

loading images, 55

Installation

overview, 13

procedure, 22

verifying, 28

Institution name, 67

Intended audience, 9

Intended use, 9

J

Job Viewer

about, 41

using, 41

K

Keyboard shortcuts

export, 37

general, 36

image viewer, 37

L

Language settings, 67

License file

backing up, 69

restoring, 69

Locking the software, 36

Logging off, 36

Logging on, 35

Loops

saving as movie, 66
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M

Measurement labels

copying, 81

creating, 80

deleting, 82

editing, 81

Measurement tools references, 85

Measurements

analysis configuration, 77

custom labels, 80

derived calculations, 82

importing configuration settings, 70

Simpson's methods, 79

SR mapping, 60, 61

MSXML 6 SP2, 15

MVI

loading images, 55

MVN

loading images, 55

N

Native data compatibility, 44

Navigation

full-screen mode, 42

message bar, 40

Network requirements, 16

configuration settings, 17

installation, 16

Network settings, 71

checking, 71

Notifications

caution, 40

message bar, 40

note, 40

warning, 40

O

Operating notes, 10

Options, 43

viewing, 44

Overview, Q-Station, 33

P

PACS compatibility, 44

PACS data

retrieving, 48

Patient data

exporting, 63

Pediatric echo references, 87

Philips contact information, 12

Pinging servers, 71

Preferences

CD/DVD write, 50, 51

removable media settings, 50, 51

Printing
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reports, 58

Purchasable options, 43

Q

Q-Apps, 43

Q-Assistant, 42

QLAB Advanced Quantification Software, 43

QLAB Q-Apps, 55

Q-Setups, 43

analysis, 77

Q-Station basics, 33

Q-Station language support, 45

R

Read This First, 9

References

adult echo, 87

measurement tool, 85

pediatric echo, 87

vascular, 89

Registering the software, 24

Remote access

configuring, 29

enabling, 29

Remote service

configuring, 29

enabling, 30

Reports

about, 56

advanced analysis, 57

approving, 58

editing, 57

electronic signatures, 58

printing, 58

SR mapping, 59, 60, 61

storage location, 56

viewing, 56

Requirements

computer, 14

network, 16

Restoring factory settings, 84

Restoring settings and license, 69

Retrieving

PACS data, 48

studies data, 48

ROI

loading images, 55

S

Saving

images, 65

loops in PC format, 66

Security

features, 34

patient data, 34
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policy, 34

remote access, 34

Security policy, 20

Serial number, 67

Service, customer, 12

Service, requesting, 31

Settings

network and DICOM, 71

system, 67

Software registration, 24

automatic, 24

manual, 26

SQ

loading images, 55

Storage locations, 67

Studies

about, 47

archiving study data, 50

Data panel, 48

DICOM archive, 50

local patient data, 48

remote patient data, 48

transferring, 49

viewing patient data, 47

writing data to removable media, 51

Studies data

retrieving, 48

Support history, 32

Support, requesting, 31

System management, 67

System upgrades, 12

T

Testing DIOM devices, 75

Toolbars

export, 62

image control icons, 52

Tools, measurement

selecting Simpson's method tools, 79

Transferring studies data, 49

U

Upgrades, system, 12

User information

components, 10

conventions, 11

User-defined calculation labels, 80, 83

User-defined measurement labels, 80, 82

V

Vascular references, 89

Verifying software installation, 28

Viewing

reports, 56

Views
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Feedback area, 40

message bar, 40

system event area, 40

VPQ

loading images, 55
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Wall motion scoring, 54

Website, Philips, 12

Index

98 Q-Station User Manual 4535 617 35291


	Q-Station User Manual
	Contents
	Read This First
	Intended Audience
	Intended Use
	User Information Components
	User Information Conventions
	Upgrades and Updates
	Customer Comments
	Customer Service

	Q-Station Installation
	Computer Requirements
	Removing MSXML 6 SP2

	Network Requirements
	Network Requirements for Q-Station Installation
	Network Requirements for Configuring the Q-Station Computer

	Computer Security Policy Option
	Computer Security Policy Settings and Default Values
	Changing the OS Policy Settings

	Installing the Software
	Software Registration
	Automatically Registering the Software
	Manually Registering the Software

	Verifying the Software Installation

	Remote Services
	Configuring Remote Services Connection Settings
	Enabling Remote Access
	Requesting Online Support
	Viewing Support-Request History

	Q-Station Basics
	Security
	Logging On
	Locking the Software
	Logging Off

	Keyboard Shortcuts
	General Keyboard Shortcuts
	Image Viewer Keyboard Shortcuts
	Export Keyboard Shortcuts

	Common Elements
	Data Type Icons
	Messages and Notifications
	Job Viewer
	Using the Job Viewer

	Full-Screen Mode
	Q-Assistant
	Q-Setups
	Q-Station Options
	Viewing Installed Q-Station Options
	Q-Station Compatibility
	Q-Station Language Support

	Working with the Q-Station Software
	Studies
	Data Panel
	Retrieving Study Data from PACS/Archive
	Transferring Studies Data to Your Workstation
	Archiving Data to a DICOM Archive
	Setting CD/DVD Write Preferences
	Writing a Disc Using Preferred Settings

	Viewing
	Displaying the Image Toolbar
	Image Toolbar Controls
	Performing Wall Motion Scoring
	Annotating an Image
	Capturing an Image

	QLAB Q-Apps for Analyzing Images
	Analyzing Images with QLAB Q-Apps
	Opening Multiple Images in a Q-App

	Reports
	Viewing Reports
	Editing a Report
	Setting Electronic Signatures on Reports
	Approving a Report
	Printing a Report
	Custom Report Templates
	SR Mapping
	Mapping Imported Measurements
	Remapping Imported Measurements
	Unmapping Imported Measurements


	Exporting
	Displaying the Export Toolbar
	Export Toolbar Controls
	Patient Data Export
	Exporting Data in DICOM Format
	Saving Images
	Saving a Loop as a Movie


	System Management
	Specifying System Information
	Data Locations
	Specifying Data Storage Locations

	Backing Up Configuration Settings
	Restoring Configuration Settings
	Importing Configuration Settings

	Network and DICOM Settings
	Checking Network Settings
	Adding DICOM Devices
	Editing DICOM Devices
	Deleting DICOM Devices
	Testing DICOM Devices

	Analysis Configuration
	Tools and Results Tab
	Configuring Measurement Results
	Hiding the Doppler Velocity Minus Sign
	Selecting a Measuring Tool for the Simpson's Method

	Calc List Tab
	Configuring the Calc List

	Measurements Tab
	Creating New Measurement Labels
	Copying Measurement Labels
	Editing Measurement Labels
	Deleting Custom Measurement Labels

	Derived Calcs Tab
	Viewing a Calculation Label
	Creating, Copying, or Editing a Calculation Label
	Deleting a Custom Calculation Label

	Report Meas/Calc Config Tab
	Factory Settings Tab

	References
	Measurement Tool References
	Adult Echo References
	Pediatric Echo References
	Vascular References

	Index


